R&S®ARB Toolbox
PC Software
User Manual
# Contents

1 Program Features ................................................................. 5

2 Installation ............................................................................. 6
   2.1 Prerequisites ................................................................. 6
   2.2 Supported Operating Systems ........................................ 6
   2.3 Supported Instruments .................................................. 6
   2.4 Installation Procedure on Windows ................................... 7

3 Command Line Options ........................................................... 8

4 Getting Started ....................................................................... 9
   4.1 Task Mode ......................................................................... 9
   4.2 Browser Mode ................................................................... 10

5 Configuring Instruments ........................................................ 12

6 Defining the Application Colors ............................................. 15

7 Using the Browsers .................................................................. 17
   7.1 Local File System Context Menu ..................................... 18
      7.1.1 Folder Options ......................................................... 18
      7.1.2 File Options ............................................................. 19
   7.2 Remote File System Context Menu ................................... 22
      7.2.1 Folder Options ......................................................... 22
      7.2.2 File Options ............................................................. 23

8 The Signal Creation Module .................................................... 24
   8.1 Waveform Types ............................................................. 28
      8.1.1 Function ................................................................. 28
      8.1.2 Expression .............................................................. 29

9 The Waveform Viewer ............................................................ 32

10 The PDW Viewer ................................................................. 36
   10.1 Pulse Video ................................................................. 36
   10.2 Polar Display ............................................................... 39
11 The Marker Editor ................................................................. 41
12 The Level Scaling Module ................................................... 43
13 The Wrap-Around Analysis Module ................................. 45
14 The Clipping Module ......................................................... 47
15 The Waveform Composer .................................................. 49
   15.1 The Track Editor ................................................................. 50
      15.1.1 Center Information ......................................................... 51
      15.1.2 Offline Files ................................................................. 52
      15.1.3 Wrapped-Around Segments ........................................... 54
      15.1.4 Truncation ................................................................. 54
      15.1.5 Fade-In and Fade-Out .................................................. 55
      15.1.6 Setting the End Position ............................................. 56
   15.2 Zooming and Navigation ........................................... 56
   15.3 Adding and Removing Segments .................................. 56
      15.3.1 Cursor Control ................................................................. 56
      15.3.2 Insert ........................................................................... 57
      15.3.3 Overwrite ................................................................. 57
      15.3.4 Extract ....................................................................... 57
      15.3.5 Lift ............................................................................. 57
   15.4 Segment Settings .......................................................... 57
      15.4.1 Attenuation Settings ...................................................... 58
      15.4.2 Frequency Settings ....................................................... 59
      15.4.3 Truncation ................................................................. 61
      15.4.4 Position in Output ....................................................... 61
      15.4.5 Flags ........................................................................ 61
      15.4.6 Fade-In and Fade-Out .................................................. 62
   15.5 Target Waveform Settings ............................................. 63
   15.6 Building the Target Waveform ......................................... 64
16 Capturing with the Spectrum Analyzer ................................. 66
17 Remote Control ................................................................. 70
   17.1 Job Description ................................................................. 70

Contact information ................................................................ 73
1 Program Features

The ARB Toolbox is a powerful and easy-to-use set of tools for creating or manipulating waveforms for R&S vector signal generators and baseband IQ modulation generators. Use the Toolbox on a PC to:

- Generate many analog modulated waveforms, such as AM, FM, PM, Pulse, Multi Carrier, and Noise.
- Create R&S ARB waveforms from custom data, MATLAB .mat files, R&S .wav, R&S AMMOS IF (.dat), or R&S iq.tar files.
- View the waveform content as I/Q, power, phase, or frequency versus time. Additionally see spectrum and I/Q constellation or density plot.
- View R&S PDW files (.ps_def) created with R&S Pulse Sequencer
- Import I/Q data from the most recent Rohde & Schwarz spectrum analyzers. Capture I/Q data and save it as a waveform file.
- Flexibly combine waveforms to form a single new waveform. Combine data from up to 16 parallel tracks; place waveform segments freely in time and frequency domain.
- Convert data from the R&S®IQR I/Q Data Recorder to R&S ARB waveform files.
- Import data from the R&S®PR100 portable radio transmissions monitor and convert the data streams to R&S ARB waveform files.
- Resample a waveform to change the target clock rate or sample count, Rescale the peak power value. Change the RMS signal level of a waveform. Low-pass filter waveform data.
- Clip waveform to a target peak-to-average ratio (PAR).
- Edit the marker traces of a waveform.
- Split I/Q data into two separate waveforms containing the phase and the amplitude (polar modulation).
- Analyze and fix wrap-around issues in waveform files.
- Convert existing waveforms from R&S®WinIQSIM or R&S®AMIQ into current R&S®WinIQSIM2 waveforms and migrate the waveform licensing.

To simplify file handling, the ARB Toolbox can display the directory structure of any local file system as well as file systems from R&S instruments that are connected via remote control.

As well as many other functions, the ARB Toolbox replaces the R&S®IQ Wizard, used to load IQ signal files.

ARB Toolbox is available for Windows, Linux and Mac OS X operating systems.
2 Installation

2.1 Prerequisites

Installing ARB Toolbox requires approximately 16 Mbyte of free hard disk space. Multiple temporary files are created in the systems temporary files directory. The size of these files depend on the size of the ARB waveforms worked with.

The ARB Toolbox software uses the VISA runtime environment for communicating with instruments. If VISA is not installed on your system, only local file system operations will be functional.

VISA can be obtained from Rohde&Schwarz, Keysight or from National Instruments. The Rohde&Schwarz VISA can be downloaded free of charge from the following website:

http://www.rohde-schwarz.com/rsvisa

2.2 Supported Operating Systems

ARB Toolbox is available for the following operating systems.

- Windows 7/10 as a 32-bit application
- Linux as 32-bit and 64-bit application
- MacOS X (Snow Leopard or later)

2.3 Supported Instruments

The following instruments are fully supported for use with ARB Toolbox.

- R&S®SMW200A, R&S®SGT100A
- R&S®AFQ100A, R&S®AFQ100B
- R&S®SMBV100A
- R&S®SMU200A, R&S®SMJ100A, R&S®SMATE200A

The following file formats from Rohde & Schwarz equipment is supported:

- R&S®IQR .wvh and .wvd file format
- R&S®PR100 .riq file format
- R&S .wav file format (monitoring receivers)
- R&S .iq.tar file format (spectrum analyzers)

Additionally, the spectrum analyzer import module supports I/Q data imports from the most recent Rohde & Schwarz spectrum analyzers.

### 2.4 Installation Procedure on Windows

ARB Toolbox is installed by executing the self-extracting installer software. The installer will guide you through the entire installation process.

During the installation process, the system verifies the presence of the VISA runtime environment and displays a warning if the runtime environment cannot be detected. In this case, file transfers to or from an instrument are not possible. Local file system operations remain functional.
3 Command Line Options

ARB Toolbox provides several command line options. These command line options are generally not required and are mainly used for debugging purposes.

--debug
The debug option generates additional debugging information in the message window. This option should only be used for debugging purposes, because it slows down the application significantly.

--no-visa
This option disables loading the VISA interface during program startup. If VISA is disabled, instrument communications are no longer possible. However, all local file system operations remain functional.

This option is mainly intended for Linux-based systems in which the VISA kernel module may not function correctly after a kernel update. In such cases, attempting to load VISA may crash the application.

--visa=[default|ni|rs|agilent]
This option is available on Windows-based systems only and selects the VISA driver to be used with the application. This is useful if multiple VISA installations exist and a particular driver shall be used.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>default</td>
<td>The primary VISA installation (Visa32.dll)</td>
</tr>
<tr>
<td>ni</td>
<td>The National Instruments VISA implementation (NiVisaCom.dll)</td>
</tr>
<tr>
<td>rs</td>
<td>The Rohde&amp;Schwarz VISA implementation (RsVisaCom.dll)</td>
</tr>
<tr>
<td>agilent</td>
<td>The Keysight / Agilent VISA implementation (agvisa32.dll)</td>
</tr>
</tbody>
</table>

--no-multi-process
The waveform composer detects the number of CPU cores and spawns up to eight parallel processes. This option disables CPU detection and runs a single process only.

This option is useful when the amount of CPU resources is limited and the building process is not possible because of these resource limitations.
4 Getting Started

The ARB Toolbox user interface can be toggled between two major display modes. This is the task-based mode and the browser-based mode. The operating concept is fundamentally different in these two modes.

4.1 Task Mode

In task mode the workspace shows a column based overview of all ARB Toolbox tasks. A left mouse click on a task name starts the task.

In most cases a file selection dialog will appear after a task was selected.
4.2 Browser Mode

In browser mode, the workspace is divided into a left and a right file browser that shows content from the local file system. By default, both browsers show the local file system. Drive and directory items can be expanded by clicking the small arrows next to the items icons.

A right mouse click on an item opens a context menu with all available options for the item. These options are described later in this document. Additionally, all available options can be accessed via the applications menu bar. Options that do not fit the selected item are dimmed in the menu bar.

Each of the file browsers can be operated on the local file system or on the remote file system of any supported Rohde & Schwarz instrument. The remote file system browsers access the instrument via SCPI mass memory commands. Both browsers operate independently with one exception: The same instrument cannot be used simultaneously in both browsers.

Drag and drop is supported between the two browsers. The software supports the copying of files and of entire folder structures between local and instrument file systems and between two instrument file systems.
Drag and drop does not currently support multiple selections, nor does it support operations between two local file systems.

Each of the two browsers provides a set of navigation controls that are located above the browser windows.

**Local or remote browser**

**Instrument**

**Filter mask**

Instrument control sets the file browser operating mode to either the local file system or the instrument file system. If an instrument becomes unavailable, the associated browser is automatically switched back to local file system mode.

Filter mask

The files shown in the file browser can be restricted to certain file types.

Last path

This field contains the recently visited locations for the associated file browser and can be used to go back to any of these locations.
5 Configuring Instruments

To use the file browsers with remotely connected instruments, these instrument connections must first be configured. This is done with the Instrument Configuration dialog by selecting Instrument → Configure from the menu bar.

The section at the top of the dialog box contains controls for adding instruments by manually entering them or by scanning the local LAN, USB or GPIB bus.

The GPIB scan is limited to the first GPIB card that is installed (GPIB0).

The lower section of the dialog box contains the list of all known and previously configured instruments. This list contains the instrument, its remote control interface and its instrument properties as well as a checkbox that enables the instrument to be used with the file browsers. Disabling an instrument in the list is useful if it is temporarily unavailable but should not be deleted from the list. If an instrument is deselected, and it is currently being used in one of the browser windows, the associated browser window is set to the local file system mode.
Comment

An optional comment can be added to each instrument in the list. A double click on the instrument name opens the edit dialog for the comment field. Comments can be used for explanatory purposes, and they do not affect instrument communications.

Add (+)

Adding an instrument manually requires entry of the instrument's host name or IP address, or a complete VISA resource string. For instruments connected via LAN, the host name is usually the instrument name followed by the serial number – for example: rssmu200a100123. Typical examples are listed below:

- **IP address:** 10.111.10.123
- **Host name:** rssmu200a255123
- **VISA resource string:**
  - TCPIP::10.111.10.123::INSTR
  - TCPIP::10.111.10.123::5025::SOCKET
  - GPIB0::28::INSTR

Firewalls

Please note that firewalls or system settings may prevent LAN access to the instrument. ARB Toolbox tries to detect the availability of required TCP/IP ports prior to attempting to open the VISA link. Error messages are displayed in the program message area.

Scan GPIB

Scans the local GPIB bus for available instruments and adds the detected instruments to the list.

Scan USB

Scans for valid instruments that are connected via USB.

Scan LAN

Scans for valid instruments in the local LAN.

Refresh

All available instruments are marked with a colored icon, whereas unavailable instruments use a dimmed icon. Available instrument nodes also provide additional instrument information when the node is expanded. The Refresh button updates the status of all listed instruments.
Delete

The Delete button removes the selected instrument from the list. If the selected instrument is currently used in one of the browser windows, the associated browser is set to local file system mode.

Delete All

This button clears the entire instrument list. Both browser windows are set back to the local file system mode.

The same instrument can be added multiple times using different hardware interfaces. For example, an instrument can be added using a GPIB connection and a USB connection. The file browsers can then be set for using the instrument with either of these interfaces.
6 Defining the Application Colors

The application colors can be changed globally using the Application Colors dialog. Access this dialog from the menu bar under Program → Colors.

All color changes are applied immediately in all application windows. It is therefore possible to open windows, such as the waveform viewer, and to observe the color change.

Preset
The entire application can be set to one of the predefined color schemes or to a user-defined color set.

Save As…
This button saves the user color scheme to a file.

Load…
This button loads a color scheme from a file and replaces the current user color set.

Brightness
The brightness control changes the brightness for the entire application. Changing the brightness setting does not affect any of the user's color definitions.

Contrast
The contrast control changes the contrast setting for the entire application. Increasing the contrast reduces the brightness of background colors and increases the brightness of foreground colors. Changing the contrast does not affect any of the user's color definitions.

Color tiles
The small colored tiles represent the color of the individual elements. One of these tiles can be selected for editing using the HSV color controls.

HSV color control
The application uses the HSV color model for defining the application colors. This color model uses hue, saturation and value instead of red, green and blue components. Hue represents the angle on the color wheel between 0° and 360°. This value is meaningless for non-chromatic colors, e.g. gray. The saturation is set in the range between 0 and 255; it defines how strong the color is. Grayish colors have very low saturation, whereas strong colors use high saturation values. The value defines the lightness; this parameter is also set between 0 and 255. The brighter the color is, the higher the value.
7 Using the Browsers

Both browsers can be operated in either the local file system mode or the remote file system mode. The operating mode is set using the control at the top of each browser. It always shows the “Local” entry as well as all available instruments.

Local file system

In local file system mode, the browser shows four columns that contain the item name, size and type along with the file modification date. By default, all entries are sorted by name in ascending order. Folders are always listed first. On a Microsoft Windows-based system, the root nodes are the available drives (e.g. “C:” or “D:"). Linux-based systems use the file system root “/” as the root node. The icons used in the tree are the regular operating system icons.

Remote file system

The remote file system contains three columns with the name, size and item type. By default, all entries are sorted by name in ascending order. Folders are listed first. The root nodes depend on the instrument. Microsoft Windows-based instruments usually use "D:" as the root node for user data. Linux-based instruments provide "/var/user/" for user data. If an additional hard drive is present, the "/hdd/" node becomes available. The icons are internally defined and depend on the item type.

A right mouse click on an item in one of the browser windows opens a context menu that contains useful options for this item. The context menu actions therefore depend on the file system mode (local or remote) as well as on the selected item (file, folder, type).
7.1 Local File System Context Menu

The selection of menu entries that is available in the context menu depends on the item that is currently selected in the file browser. The following section lists the menu entries that are available for files and folders.

7.1.1 Folder Options

The menu entries listed below are available when a folder has been selected in one of the file browsers. This folder is shown in the "recent locations" control above the file browser. The blue paper clip indicates which file browser is currently active.

Most menu entries are also available in the application's main menu bar.

Create Folder

Creates a new folder inside the currently selected folder. The following characters are not allowed as part of the folder name: * # + / \ ‘ ” ? %. The folder cannot be created if another entry with the same name already exists inside the selected folder.

Rename

Renames the selected folder. The following characters are not allowed as part of the folder name: * # + / \ ‘ ” ? %. The folder cannot be renamed if another entry with the same name already exists inside the selected folder.
Delete

Deletes the selected folder if it is empty. If the folder contains entries, the user is asked if the folder and all its entries should be removed.

File → Create Signal

Starts the signal creation module. This module allows generation of many analog modulated waveforms, such as AM, FM, PM, Pulse, Multi Carrier, and Noise. A separate section in this manual describes this module in greater detail.

Import → Import From Analyzer

Starts the import module for the spectrum analyzer data. This module connects to a spectrum analyzer, captures I/Q data and saves this data as a waveform file in the current folder. A separate section in this manual describes this module in greater detail.

Edit → Composer

This action starts the waveform composer module. This module is used to combine multiple waveforms to form a single new waveform. A separate section in this manual describes this module in greater detail.

Edit → Convert .wv Files

This menu item starts the waveform conversion. This module converts waveforms in the WinIQSIM format to waveforms in the WinIQSIM2 format. The conversion also changes the waveform licensing to the current K-options.

7.1.2 File Options

Analyze → Waveform Info

This menu item is only available when a waveform file (.wv) is selected. The waveform information module evaluates information from the waveform file, such as the clock rate, number of samples, crest factor, playtime, and comment.

Analyze → View

This menu item starts the waveform viewer module and is only available when a waveform file (.wv) is selected. The viewer reads in all of the waveform data and displays I and Q data, the spectrum and a constellation diagram of a signal section or of the entire waveform. A separate section in this manual describes the waveform viewer in greater detail.
Analyze → Wrap Around
This menu item starts the wrap around analysis module and is only available when a waveform file (.wv) is selected.

File → Create Signal
Starts the signal creation module. This module allows generation of many analog modulated waveforms, such as AM, FM, PM, Pulse, Multi Carrier, and Noise. A separate section in this manual describes this module in greater detail.

Import → Import Data
This menu item is available for all files. It starts the data import module. This module converts binary or text data into a Rohde & Schwarz waveform file.

Import → MATLAB
This menu item is only available for files that have the "mat" ending. It starts the MATLAB data conversion module, which displays the variables contained in a MATLAB .mat file and allows the user to select one 1xN or Nx1 complex double array for conversion into a Rohde & Schwarz waveform file.

Import → RIQ
This menu item is only available for files that have the "riq" ending. It starts the RIQ data conversion module, which converts data streams that have been captured by the R&S®PR100 and saved on its memory card.

Import → WAV
This menu item is only available for files that have the "wav" ending. It starts the WAV file conversion module, which converts data that has been saved by the R&S®EM100-Control software.

Import → WVH
This menu item is only available for files that have the "wvh" ending. It starts the R&S®IQR conversion module. The matching .wvd file is expected at the same location as the .wvh file.

Edit → Resample
This menu item starts the resampling module and is only available if a waveform (.wv) file is selected. This module is used to resample a signal to a given clock rate or sample count. The resampling sequence contains the following steps:

Read waveform data from file.
Resample to target clock rate or sample count.
Rescale to the same peak power value.
Write new waveform file to disk.

The resampling algorithm uses a lowpass filter with a cutoff frequency of 0.45 times the sample rate.

**Edit → Filter**
This menu item starts the filter module and is only available when a waveform file (.wv) is selected. This module provides a configurable lowpass filter that can be used for limiting the signal bandwidth. The filter sequence contains the following steps:

- Read waveform data from file.
- Filter waveform data.
- Rescale to the same peak power value.
- Write new waveform file to disk.

**Edit → Level**
This menu item starts the level adjustment module and is only available when a waveform file (.wv) is selected. The module is used to change the waveform's RMS signal level based on a user-definable signal section.

**Edit → Clip**
This menu item starts the waveform clipping module and is only available when a waveform file (.wv) is selected. The waveform clipping module is used to limit the peak-to-average ratio of a signal to a target value.

**Edit → Edit Markers**
This menu item starts the marker editor module and is only available when a waveform file (.wv) is selected. The marker editor is used to edit the marker traces graphically.

**Edit → To Polar**
This menu item starts the polar conversion module and is only available when a waveform file (.wv) is selected. This module converts a waveform into two separate waveforms that contain the phase and amplitude information.

**Edit → Composer**
This menu item starts the waveform composer module and is only available when a composer settings file (.cms) is selected. This module is used to generate complex multicarrier scenarios.
Edit → Convert .wv Files

This menu item starts the waveform conversion module and is only available when a waveform file (.wv) is selected. This module converts waveforms in the WinIQSIM format to waveforms in the WinIQSIM2 format. The conversion also changes the waveform licensing to the current K-options.

7.2 Remote File System Context Menu

Which menu items are available in the context menu depends on the currently selected entry. The following section lists the available menu items for a selected folder or file entry in a file browser that is set to remote file system mode.

7.2.1 Folder Options

Set As Default Folder

Sets the currently selected folder as the default folder. This folder is always opened by default when this instrument is used with one of the browsers.

Create Folder

Creates a new folder inside the currently selected folder. The following characters are not allowed as part of the folder name: * # + / \ & ' " ? %. The folder cannot be created if another entry with the same name already exists inside the selected folder.

Rename

Renames the selected folder. The following characters are not allowed as part of the folder name: * # + / \ & ' " ? %. The folder cannot be renamed if another entry with the same name already exists inside the selected folder.
Delete
Deletes the selected folder and all its subfolders and files. To prevent accidental deletions, the user is asked if the folder and all its subfolders and items should be deleted.

7.2.2 File Options

Run!
This menu item starts the selected waveform (.wv) in the instrument's ARB. When used with a two-path instrument, the waveform is started in the first path.

Create Folder
Creates a new folder inside the folder where the currently selected file is located. The following characters are not allowed as part of the folder name: * # + / & ' “ ? %. The folder cannot be created if another entry with the same name already exists inside the selected folder.

Rename
Renames the selected file. The following characters are not allowed as part of the file name: * # + / & ' “ ? %. The file cannot be renamed if another entry with the same name already exists inside the current folder.

Delete
Deletes the selected entry.
8 The Signal Creation Module

The signal creation module is started via the context menu in the local file-system browser. This module is used to build various analog modulated signals, such as AM, FM, PM and noise.

The signal creation wizard guides the user step by step through the configuration and waveform building process.

The first page of the wizard configures the signal type as well as the minimum and maximum permissible ARB clock rate. Please see your instrument's operating manual for information about the ARB clock rate limits.

The final waveform's ARB clock rate is determined by the signal creation wizard. It is not possible for the user to set this rate directly.

The Next (>> ) button advances the wizard to the second page, where the signal type can be specified in more detail.
The second page of the signal creation wizard sets all parameters required for the selected signal type. As a result, the content of this page depend on the signal type that has been set on the first page.

All entry fields on the settings panel provide tool tips with information about permissible value ranges for the entry field.

After editing all parameters, clicking the Next ( >> ) button advances to the waveform preview panel.

The Previous ( << ) button is used to go back to the first page of the signal creation wizard. Settings made on this page are saved and restored if the page is activated again.
The third page of the signal creation wizard shows a preview of the waveform that is generated.

For large waveforms, the preview panel limits the view to the beginning portion of the waveform.

**Scaling**

The output waveform can be generated using two different level-scaling modes. The "No Scaling" selection leaves the signal amplitude untouched. This could lead to low signal levels or clipping, and it is only recommended for specific applications. The "Auto Scaling" mode scales the waveform so that it perfectly fits the 16 bit dynamic range of the instrument's ARB. No clipping is performed when auto scaling is selected.

**Force Zero Peak/RMS**

ARB Toolbox calculates the peak power and RMS power for the entire waveform and saves this information as part of the waveform file. The generator uses these values to ensure correct leveling and to inform the user about over-range conditions. The Peak/RMS ratio defines the difference between the power level that is set by the user and the peak power generated by the instrument. For example, if the Peak/RMS ratio is 10 dB and the user sets an average power level of +15 dBm, signal peaks of 25 dBm will occur.
For most signals, it is a good idea for the user to control the waveform's RMS power. For some signals, such as pulses, the RMS signal level is of little interest. In this case, the user controls the top pulse power and forces the Peak/RMS value to be zero.

**Samples**

The indicator field is read only. It displays the number of samples that the final waveform contains. An exclamation mark warns the user if the sample count falls below 512 samples. In this case, the waveform length might violate the minimum required ARB file size.

**Clock Rate**

The indicator field is read-only. It shows the final waveform's clock rate. The clock rate is selected by the application, and it fits into the range that is established by the minimum and maximum permissible ARB clock rates.

**Peak Vector**

The indicator field is read-only. It shows the peak magnitude of the I/Q samples that are evaluated in the preview window. To avoid signal clipping, the number must not exceed 1.0. If auto scaling has been selected, the application will first create the signal and then scale it to a peak vector of exactly 1.0.

**Peak / RMS**

The indicator field is read-only. It shows the relation between the peak power and the RMS power of the evaluated waveform section. The ratio is expressed in dB.

If the preview shows satisfactory results, use the Next ( >> ) button to advance the signal creation wizard to the waveform file settings page. This page sets the output file name, provides optional comment information, and builds the output file.
8.1 Waveform Types

8.1.1 Function

The function setting creates sine, square, triangular, or sawtooth signals. These signals are equally built for I and Q but the amplitude and level offset can be set independently. Additionally, the Q signal may be phase shifted to the I signal.

Function Generator

<table>
<thead>
<tr>
<th>Frequency</th>
<th>10 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd Frequency</td>
<td>20 kHz</td>
</tr>
<tr>
<td>Duration</td>
<td>10 ms</td>
</tr>
<tr>
<td>Custom Oversampling</td>
<td>100</td>
</tr>
<tr>
<td>Amplitude I</td>
<td>0.707</td>
</tr>
<tr>
<td>Offset I</td>
<td>0</td>
</tr>
<tr>
<td>Offset Q</td>
<td>0</td>
</tr>
<tr>
<td>Phase Shift Q</td>
<td>90°</td>
</tr>
</tbody>
</table>

Setting a second frequency creates a frequency sweep. The result is a waveform that starts with the signal frequency and ends with the second frequency. The duration defines the amount of time in which the frequency changes.
8.1.2 Expression

The waveform is built from data calculated by two mathematical expressions. These two expressions either describe I/Q, amplitude and phase, or amplitude and frequency versus time. The syntax of the mathematical expression parser is described below.

Mathematical Expression

Variables

t   current time 0…T
s   current sample 0…N

Constants

T   total time
N   total number of samples
CLK clock rate in Hz
ST  sample time (1/CLK)
PI  the value of Pi

Operators

x * y multiplication
x + y addition
x – y subtraction
x / y division
x ^ y  \quad y \text{ by the power of } y

Random numbers

rand()  \quad \text{random number between 0…1}
grand()  \quad \text{gaussian random number}

Trigonometric functions

\sin(x)  \quad \cos(x)  \quad \tan(x)
\sinh(x)  \quad \cosh(x)  \quad \tanh(x)
\text{asinh}(x)  \quad \text{acosh}(x)  \quad \text{atanh}(x)
\text{asin}(x)  \quad \text{acos}(x)  \quad \text{atan}(x)

Logarithmic functions

\log_2(x)  \quad \log_{10}(x)  \quad \log(x)  \quad \ln(x)  \quad \exp(x)

Other functions

\sqrt{x}  \quad \text{square root}
\text{sign}(x)  \quad \text{sign (-1 if } x<0; +1 \text{ if } x>0)
\text{rint}(x)  \quad \text{round to nearest integer}
\text{abs}(x)  \quad \text{absolute value}
\text{floor}(x)  \quad \text{largest previous integer number}
\text{ceil}(x)  \quad \text{smallest following integer number}
\text{mod}(x,y)  \quad \text{modulo division}

Piecewise defined functions (conditions)

<condition> \quad ? \quad <expression_1> : <expression_2>

The following examples demonstrate how to use mathematical expression to generate various waveforms. ARB toolbox allows to control the signal amplitude and frequency by two independent equations. If the signal amplitude remains constant the value ‘1’ needs to be added in the expression field.

Linear frequency sweep from -100 kHz to + 100 kHz

AM  \quad = 1
Freq  \quad = -100e3 + 200e3 \times (t/T)
Non-linear chirp

AM = 1
Freq = 0.5 * 100e3 * (-1+2*t/T) +
      0.5 * 20e3 * (-1+2*t/T) /
      sqrt( 1.001 - (-1+2*t/T)^2 )

Pulse with exponential rising and falling edge

AM = t<T/2 ? 1-exp(-20*t/T) : exp(-20*(t-T/2)/T)
Phase = 0

Gaussian pulse

AM = exp( -0.5 * ( (t-T/2)/(T/8) )^2 )
Phase = 0
9 The Waveform Viewer

Start the waveform viewer module via the context menu for a waveform file entry in the local file-system browser. The viewer reads the entire waveform data and provides three display sections on one single panel: The time domain view, the spectrum and the I/Q constellation.

Navigation controls

The number of signal samples that are displayed in the viewport can be set between 50 and 100 000. In most cases, the viewport window is used to display only a section of the entire waveform. The navigation controls on the left side above the viewport window step forward or backward to the beginning or end of the waveform.

Timeline

The timeline is located above the viewport window. It provides multiple functions. The length of the timeline symbolizes the play time of the entire waveform. The green section marks the area of the waveform that is currently visible in the viewport. When the mouse cursor is moved close to the timeline, a red dot indicates the time that corresponds to the mouse position. This time is also displayed numerically above the timeline. A left mouse click adjusts the viewport center position to the selected time.
Zooming

The number of samples shown in the viewport window is controlled by two zoom buttons. The zoom range is either defined in samples or time.

View mode

The window size and the screen resolution limit the number of screen points in the time domain display. This also limits the resolution at which level and time information is represented. Particularly when a large signal section must be displayed, one single screen point may contain the information from a large number of signal samples. In this case, view mode can control the information that is displayed.

I/Q Envelope

The "I/Q Envelope" mode displays the I and Q trace on a linear scale in the range between –1.0 and +1.0. The lower section contains the four digital marker traces M1 to M4. Depending on the zoom level, each screen point may represent multiple signal samples. If so, the area between the minimum and maximum value is filled with a semi-transparent trace color.

Log Mag Envelope

The "Log Mag Envelope" mode displays the logarithmic signal amplitude on a 100 dB scale. The lower section contains the four digital marker traces M1 to M4. When one screen point represents multiple signal samples, the area between the minimum and maximum value is filled with a semi-transparent trace color.

Log Mag Average

In contrast to the "Log Mag Envelope" mode, the area between the minimum and maximum value is not filled in this mode. Instead, the average value is displayed when multiple samples are represented by one screen point.

Lin Mag Average

The "Lin Mag Average" mode is similar to the "Log Mag Average" mode, but it uses a linear scale between zero and one.
Spectrum

The spectrum panel shows the FFT of the signal portion that is visible in the viewport. The FFT scale has a range of 150 dB, and it is sufficient to cover the 16 bit resolution provided by the vector signal generator's internal ARB (96 dB). The frequency scale ranges from –1/2 to +1/2 of the waveform sample rate.

The FFT algorithm processes the waveform data in sections of 512 points. Each section is multiplied with a raised cosine window. Adjacent sections overlap each other by half the section length. After all FFT windows are calculated, the average of all results is created and displayed.

Care must be taken when short signal portions are to be evaluated. In this case, the windowing function weights the beginning and end of the waveform less than the center portion.

Waterfall

The waterfall panel shows the spectrum of a signal portion as a function of time. Each line in the waterfall diagram represents one FFT with 512 points.

The waterfall diagram uses a color scale to represent a dynamic range of 150 dB.
I/Q constellation plot

The I/Q constellation plot operates in two different modes depending on the number of samples visible in the viewport. When the number of samples is relatively low, the panel shows the I/Q samples as dots.

The display covers the range between $-1.0$ and $+1.0$ for I and Q. The outer circle marks the vector length of 1.0. Samples located outside of this circle are subject to clipping when the waveform is played back in the ARB.

The inner circle marks the vector length $1/\sqrt{2}$. Samples located on this circle generate an output power of 3 dB below the maximum.

If a large number of samples are to be evaluated, the display mode changes from a single sample display to a density plot display. In this operating mode, the display is divided into a grid of 50 by 50 points, and the number of samples that fall within each point is counted. Finally, the sample counts are translated to:

Play / stop

The play button starts the graphical waveform playback. In this mode, the waveform section is shifted in time by one half of a display section every 100 ms. If CPU performance is insufficient for this, the update rate is decreased to 200 ms.
10 The PDW Viewer

Start the PDW (Pulse Descriptor Word) viewer module via the context menu for an AMMOS pdw or R&S Extended Sequencing file entry in the local file-system browser. The viewer reads the entire PDW data and provides three display panels: The graphical pulse video, the table, and the polar display.

All three displays visualize a section of the entire signal. This segment is defined by a start time and a number of pulses. Use the navigation and zoom controls to define which section is shown.

Navigation

These controls define the start time of the displayed signal section. If a numeric value is entered in the entry field the display starts searching for the pulse starting on this point in time. If a pulse cannot be found the next pulse with a start time greater than the entered value will be used as the first pulse.

Zoom

The zoom controls define the number of PDWs show on all displays. Zooming in removed the number of PDWs. Zooming out increases the number of PDWs. The start time (left border) remains constant during zoom operations.

The viewer records the last zoom and navigation steps in memory. This allows easy stepping through past zoom steps.

10.1 Pulse Video

The pulse video visualizes a segment of the signal. The user can toggle pulse attributes on or off and define individual attribute scales.
One attribute is selected as the current attribute. This attribute is affected by Y-zoom operations.

Attributes

The attribute buttons toggle the PDW attributes on or off. A minimum of one attribute is always toggled on.

Level
Displays the PDW level in dBm. Signal generator files (Extended Sequencing) use 16 bit for the level information. The dynamic range is therefore limited to 96 dB and the logarithmic level steps increase the lower the level in the PDWs is.

PW
Displays the pulse width. The pulse width value is not available in Extended Sequencing files with I/Q segments selected as pulse content. In this case the pulse width is determined by the number of samples in the referenced waveform.

PRI
Displays the pulse repetition interval. The PRI value is the time from the rising edge of the current pulse to the rising edge of the subsequent pulse (forward PRI). The PRI values are calculated from the TOA (time of arrival) values and thus can be wrong if pulses were skipped or originate from different sources.

Frequency
Displays the center frequency of the pulse. PDWs originating from R&S monitoring equipment use the absolute pulse center frequency.
AOA
Displays the angle of arrival in degrees between 0 and 360. The angle of arrival value is usually only available for PDWS recorded with R&S monitoring equipment.

DF Qual
Displays the direction finding quality indication. This button is only available if the PDW data is created with R&S monitoring equipment.

Mode
This control toggles the display mode between Pulse Count and Time.

Current Attribute
A color bar at the right border shows the currently active attribute. The Y-scale values are related to this attribute. Y-Zoom operations only affect the current attribute.

Out of Range Arrows
Small out of range arrows appear above or below the right side of the graphics panel and indicate that PDW attributes are out of range. Clicking on one of the arrows adjusts the affected minimum or maximum range of the Y-axis accordingly.

The PRI scaling ignores large out of range PRIs that are caused by signal breaks. After an auto scaling operation the out of range arrow might therefore still remain active.

Zoom/shift arrows
When the mouse pointer is positioned on the y-axis, arrows appear which indicate what action is performed if the left mouse button is clicked. This functionality is useful for scaling/repositioning each attribute within the display.

- Center arrow: when this arrow is displayed, the currently selected attribute can be shifted vertical by dragging the mouse. For example, if the current attribute is PRI, left-click + drag the mouse = all the plotted PRT points can be moved up or down in the view.
- Upper arrow: when this arrow is displayed, the currently selected attribute can be zoomed in or out by dragging the mouse. Note that this zoom only changes the upper y-axis limit - i.e. the plotted points move relative to the bottom of the display.
- Lower arrow: when this arrow is displayed, the currently selected attribute can be zoomed in or out by dragging the mouse. Note that this zoom only changes the lower y-axis limit - i.e. the plotted points move relative to the top of the display.

Zoom with CTRL + mouse
You can quickly zoom the current attribute vertically by holding the CTRL key and dragging the mouse in the y-axis while holding the left mouse button. This action causes a rectangle to be drawn in the display and you can select the range to be zoomed.

10.2 Polar Display

The polar display visualizes the pulse level as well as the angle of arrival (AOA) at which pulses were received.

The display indicates the angle where the maximum pulse power occurs with a small arrow. All pulses are drawn semi-transparent, hence pulses that occur repeatedly at the same level and angle appear in a brighter color.

**Zoom/shift arrows**

When the mouse pointer is positioned on an axis between the center of the display and the lower border, arrows appear which indicate what action is performed if the left mouse button is clicked. This functionality is useful for scaling the display.

- Center arrow: When this arrow is displayed, the level range remains constant but the absolute position of the level range is moved up or down.
- Upper arrow: when this arrow is displayed, the minimum level is changed by dragging the mouse.
- Lower arrow: When this arrow is displayed, the maximum level is changed by dragging the mouse.
11 The Marker Editor

Start the marker editor module via the context menu for a waveform file entry in the local file-system browser. The marker editor reads all the waveform data and provides a view of the I/Q data and the marker traces. Additional controls in the lower panel area are used to modify the marker traces.

![Marker Editor Interface]

**Navigation controls, zooming, view mode, timeline**

Please see the Waveform Viewer section in this manual.

**Cursors**

The viewport provides three cursors. The primary cursor is indicated by a single line and is located in the I/Q data area. It marks the center point for all zoom operations. The other two cursors are indicated by brackets and are located in the marker area. They define the beginning and end point for all marker operations. The "Set" buttons set the marker brackets to the current cursor position.
**Marker bracket controls**

Both marker brackets can also be set numerically using the controls located below the viewport window. All marker operations are applied to the area defined by the two brackets, including the boundaries.

**Marker modification**

The marker modifications are applied between the two marker brackets, including the boundaries. The modification controls define the modification type and the affected marker traces. The "Apply" button performs the change immediately.

---

The marker change is executed immediately and without confirmation. No undo functionality is provided, because this requires the buffering of an extremely large amount of data. Instead, all changes are applied to temporary waveform data. The final waveform is built from this data when the "Run" button is pressed. If unwanted marker changes have been made, it is sufficient to close the panel and restart.

---

**Run**

The "Run" button builds a new waveform from the I/Q data and the modified marker data.

**Close**

The button closes the dialog. If changes have been made, the user is queried if the modified data should be saved prior to closing the dialog. Once the panel is closed, all marker changes are lost.
12 The Level Scaling Module

Start the level scaling module via the context menu for a waveform file entry in the local file-system browser. It reads the entire waveform data and provides a view of the I/Q data versus time. Additional controls in the lower section of the panel define the signal portion that is used for calculating the RMS signal level.

Navigation controls, zooming, view mode, timeline

Please see the Waveform Viewer section in this manual.

Cursors

The viewport provides three cursors. The primary cursor is indicated by a single line. It marks the center point for all zoom operations. The other two cursors are indicated by brackets. They define the beginning and end point for the RMS level evaluation period. The "Set" buttons set the brackets to the current cursor position.

Numeric bracket controls

Both brackets can also be set numerically by using the controls below the cursor navigation buttons.
**Peak and Peak/RMS display**

This section shows the Peak and Peak/RMS values based on different sources.

**Tag**

This information is based on a tag stored in the waveform file. When this information is present, the signal generator will use it for leveling. If the tag is missing, the signal generator evaluates the file content and levels automatically.

**Entire Data**

This information is calculated from all samples after the file has been read in. For most waveform files, these values are equal to the ones contained in the level tag.

**Target levels**

These controls contain the Peak and Peak/RMS levels as they will be written to the final waveform file. Both values are initialized with the values determined when the waveform was initially read in. The "Update" button recalculates the Peak/RMS level according to the section defined by the two brackets.

**Run**

The "Run" button builds a new waveform with the modified Peak and Peak/RMS levels.

**Close**

This button closes the dialog.
13 The Wrap-Around Analysis Module

Start the wrap-around analysis module via the context menu for a waveform file entry in the local file-system browser. It reads the head and tail section of the waveform and displays these sections side by side.

Wrap-around conditions occur if the end of the waveform does not match the beginning and the waveform is played continuously. In this case a broad spectrum is created when the wrap-around occurs.

This module allows the user to smooth the head and tail section. For this purpose a cutoff frequency and a correction range in samples can be provided. The smoothing algorithm creates a filtered waveform for the given sample range.

Head and Tail Sample
The head and tail sample position mark the beginning and the end of the waveform. The waveform can be truncated by changing these numbers.

Show Data
The FFT window either displays the spectrum of the original (uncorrected) or the filtered (corrected) signal.

**Cutoff Frequency**

Sets the cutoff frequency of the low pass filter used for the transition region. The fading between the original and the filtered waveform is implemented by using a raised cosine window.

**Correction Range**

This setting defines the number of samples that are affected by the smoothing operation. The fading between the original and the filtered waveform is implemented by using a raised cosine window.
14 The Clipping Module

Start the clipping module via the context menu for a waveform file entry in the local file-system browser. It reads the entire waveform and displays the CCDF as well as the spectrum of the signal before and after a clipping operation.

The clipping settings are divided into three major sections. These sections are:

- Pre-filter clipping
- Low-pass filter
- Target clipping

The target clipping value sets the peak-to-average (PAR) ratio of the final waveform. The slider below the PAR setting controls the smoothing factor of the clipping operation. Hard clipping means that all samples that exceed the maximum amplitude are clipped to this maximum amplitude. Soft clipping uses a weighting function (Rapp model) to create output samples from input samples.
The pre-filter clipping and the low-pass filter can be enabled as an option. The combination of these settings allow to generate waveforms that exhibit a good compromise of error vector magnitude (EVM) and adjacent channel power (ACP) in telecommunication standards.

Settings Example

- 3 GPP FDD waveform, Rel. 9, FWD link, R&S WinIQSIM2 default
- Target PAR should be 8.2 dB
- Software settings:

  - Pre-filter clipping
  - Target PAR should be 8.2 dB
  - Software settings:

The measurement results obtained from the above settings are summarized in the table below.

<table>
<thead>
<tr>
<th></th>
<th>Original</th>
<th>Clipped</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAR</td>
<td>10.5 dB</td>
<td>8.3 dB</td>
</tr>
<tr>
<td>ACLR</td>
<td>-71 dB</td>
<td>-69 dB</td>
</tr>
<tr>
<td>EVM</td>
<td>&lt; 0.3 %</td>
<td>2.42 %</td>
</tr>
</tbody>
</table>

As a rule of thumb the pre-filter clipping PAR should be selected such that it is about 1 dB below the target PAR. The pre-filter clipping characteristic is usually set to a soft characteristic while the target clipping model uses a hard characteristic. The basic idea behind this approach is that the first clipping stage reduces the PAR significantly. As a side effect spectral regrowth occurs that is filtered with the low-pass filter block. The side effect of the filter is that the PAR increases again. The small number of samples that remain above the target PAR are removed in the second clipping stage.
15 The Waveform Composer

Start the waveform composer module via the context menu for a folder entry or a composer settings file entry in the local file system browser. The waveform composer provides powerful and versatile functionality for building complex multicarrier scenarios.

The main purpose of the composer module is to provide the user with a flexible way for arranging various waveforms in time or in frequency. This is done by arranging waveform segments in up to 16 parallel tracks. The final waveform is built by adding all waveform data from all tracks on one common time scale.

The tracks are provided as placeholders for waveform segments. The track itself does not specify a frequency offset, level or timing. These settings are managed individually for each segment.

Each waveform segment is indicated by a colored section within the track. The section length symbolizes the play time for this segment.

The composer window is divided into four main areas. The upper left area contains the controls required for adding or removing waveforms to or from tracks. The upper right area contains the navigation controls.

The center area shows the graphical representation of the entire waveform composition or a zoomed portion of it. It also provides access to the individual track settings.
The lower composer window area contains controls for various purposes, such as cursor control, track and file management, and target file settings.

### 15.1 The Track Editor

The track editor provides two major functions. First, it visualizes the entire waveform composition and provides information about segment settings, such as the frequency offsets, level attenuation and timing. Second, waveform segment parameters can be changed by double-clicking a segment in the editor.

The left side of the track editor contains two control fields for each track. The larger field contains the track number and indicates if the track is evaluated during the creation of the final waveform. A colored field symbolizes that this track is active and evaluated. The activation state can be toggled with a left mouse click anywhere in the field.

The diamond in the smaller field on the right side is the track selection flag. It marks tracks that are affected by edit operations. In addition, the segment selection works by combining the flag with the current cursor position. Only segments from selected tracks can be marked using the cursor line. These segments appear in a slightly brighter segment color.

Insert operations work on all selected tracks. It is therefore possible to add the same waveform into multiple tracks at a common position in time.
Clicking into the smaller field using the left mouse button toggles the track selection state.

15.1.1 Center Information

Each waveform segment is symbolized by a colored area. The position of this area corresponds to the location in the output waveform. Depending on the zoom level, three lines of textual information are provided within each segment.

The first line contains the file name of the waveform segment. The file name does not contain the full path, and it may be omitted if the segment section becomes too short.

The content of the second line is user-selectable. It provides one of the following information:

**Used Samples**
This is the number of samples that are taken from the source waveform. The waveform is truncated at the beginning or the end if the number of used samples is less than the total number of waveform samples.

**First Sample**
This is the number of the first sample that is taken from the source waveform. The waveform is truncated at the beginning if the first sample is greater than zero.

**Frequency Offset**
This is the frequency offset that is set for the segment. Setting a frequency offset shifts the signal away from the carrier frequency. The frequency offset can be positive or negative. If a frequency offset is set, the segment gets marked with the "dF" symbol.

**Attenuation**
This is the level attenuation set for the segment. Setting a level offset reduces the signal level of this segment in the output waveform. Positive values reduce the signal level. If a level offset is set, the segment gets marked with the "dL" symbol.
Play Time
This is the segment's play time based on the source clock rate and the number of used samples.

Clock Rate
This is the source clock rate of the waveform used in the segment. The source clock rate may differ from the output waveform's clock rate. In this case, resampling is required, and the segment is marked with an "R" symbol.

Start Sample
This is the start sample of the segment in the output waveform. The start sample is related to the output waveform's clock rate.

Start Time
This is the start time of the segment in the output waveform.

The third row contains icons that indicate certain segment states. The following icons are used:

- R: Resampling is required for the segment. This indicates that the source clock rate differs from the output clock rate.
- dF: The segment is frequency-shifted.
- dF!: The segment is frequency-shifted. Additionally, the limit set for automatic adjustment of the frequency shift cannot be met.
- dL: The segment is attenuated.

15.1.2 Offline Files
Each segment references a waveform file containing the I/Q and marker data that is added to the output waveform during the building process. The waveform file is specified using a path relative to the composer settings file. If the waveform file becomes unavailable, the corresponding segment is highlighted in a different color. Waveform scenarios that contain unavailable segments cannot be built.
15.1.3 Wrapped-Around Segments

The beginning and end points of the target waveform are marked by thin lines. The beginning is always located on the left side at sample zero. The end point can be determined automatically or set by the user. By default, waveform segments that reach beyond the end of the target waveform are truncated. In some applications, however, it is better if the end is not truncated; instead, it should wrap around to the beginning of the target waveform. These wrapped-around segments are indicated by a hatched section at the beginning of the composition. This section cannot be selected directly by the cursor line or the mouse. Instead the "true" segment position must be used.

The wrap-around state is defined in the Segment Settings dialog. This dialog can be invoked by double-clicking any part of the segment.

Entire segments, or even multiple segments in a row, can be wrapped around to the beginning of the waveform.

15.1.4 Truncation

Waveform segments can be truncated at the beginning or the end. This is useful when only a fraction of the signal should be used in the output signal.

The truncation is defined in the Segment Settings dialog. This dialog can be invoked by double-clicking anywhere in the segment.

When segment truncation occurs, a hatched section marks its location at the beginning or at the end of the segment. The length of the hatched area is independent of the amount of truncation.
15.1.5 **Fade-In and Fade-Out**

Waveforms containing digital standard signals and originating from R&S®WinIQSIM™ are usually intended for continuous playback. The end of the waveform fits the beginning to avoid spectral regrowth caused by the wrap-around.

If such a waveform is not repeated continuously but used as source for a waveform segment, a small amount of fade-in and fade-out time may be required. Fading the waveform changes the amplitude between zero and the full signal level within the given amount of time.

Waveform fading is indicated by a small arrow at the segment boundaries.

The example waveform below shows one GSM burst originating from R&S®WinIQSIM2™. This burst was added to a track without defining a fade-out time.

It can be seen that a glitch occurs at the end of the GSM waveform (4.6 ms). This glitch is caused by the digital filter that was used when the waveform was generated.

If this waveform is played continuously, there will not be a signal glitch. Instead, the signal ramps up in such a way that the full signal level is available at the beginning of the waveform.
15.1.6 Setting the End Position

The end position of the output waveform is either determined automatically or set by the user. These settings can be entered numerically in the output waveform dialog that is described later in this manual.

An alternative method is to set the end point to the current cursor position. This can be done by invoking the context menu in the track editor and selecting “Set End to Cursor.”

15.2 Zooming and Navigation

The track editor provides a primary cursor line that serves as the center point for all zoom operations. Placing the cursor line and turning the mouse’s scroll button forward zooms in at the current cursor position. Turning the scroll button backward zooms out.

Zooming is also possible using the three navigation control buttons. The lens + and – buttons zoom in and out at the cursor position. The lens symbol with the bracket sets the view area to fit the entire waveform composition.

The two arrow buttons position the view to the beginning or end of the entire waveform composition.

15.3 Adding and Removing Segments

Adding or removing content is the track editor’s main task. The waveform composer provides two operations for adding content and two operations for removing content.

All operations on waveform segments are non-destructive and saved in a database. Therefore, each step can be undone using the “Undo” button.

15.3.1 Cursor Control

Generally, all edit operations are related to the current cursor position. Inserting and overwriting content starts exactly at the cursor position. The sample counting is zero based and starts at index 0 for the first sample.

Pressing the Control key along with the left mouse button snaps the cursor line to the closest segment border of all marked tracks. At the beginning of the composition, the cursor snaps to sample zero. At the border between two adjacent segments, the cursor snaps to the first sample of the second segment. At the end of the composition, the cursor snaps to the sample following the last segment.

Only marked tracks are affected by edit operations. Therefore, the track selection indicators (the little diamonds on the left side) must be set before adding or removing content.
15.3.2 Insert

Inserts the selected waveform at the cursor position in all marked tracks. The insert operation shifts all content following the insert position by exactly the space that the inserted signal requires. When the insert mark is placed within a segment, the segment is split, and the remaining part is shifted beyond the newly inserted segment.

Please note that the insert operation shifts track content by the size of the newly inserted segment. The timing relationship of the tracks may therefore become unsynchronized.

15.3.3 Overwrite

Overwrites the track content of all marked tracks with the selected waveform. Entirely overwritten segments are removed from the scenario. Tracks that get partially overwritten are automatically truncated.

The overwrite operation does not shift content. As a result, it leaves the tracks synchronized.

15.3.4 Extract

Removes the selected segments from all marked tracks and closes the gap for the removed segments by shifting all content following the cursor line. The segments that will be removed are determined by the track selectors (diamonds) and the cursor position.

Please note that the extract operation shifts track content individually depending on the size of the removed segments. Consequently, the timing relationship of the tracks may become unsynchronized after an extract operation.

15.3.5 Lift

Lifts the selected segments from all marked tracks and does not close the gap left by the removed segments. The segments being removed are determined by the track selectors (diamonds) and the cursor position.

The lift operation does not shift content. Therefore, it leaves the tracks synchronized.

15.4 Segment Settings

Double-clicking a segment in the track editor opens the Segment Settings dialog. This dialog contains all parameters that affect the current segment and its position in the output waveform. Each segment uses its own individual data set. All changes are added to a database, and they can be undone using the “Undo” button in the track editor.
**Source File**

This is the name of the waveform file associated with the segment. The file name also contains the absolute path but saves a path relative to the composer settings file. It is therefore possible to put the settings file together with the waveform files into one folder structure and then copy everything to a different location.

### 15.4.1 Attenuation Settings

**Static**

The attenuation reduces the signal level of the segment in the output waveform. A positive value of 6 dB, for example, reduces the RF signal level by 6 dB and the I/Q baseband level to 50%.
Expression

Instead of a static level offset a mathematical expression may be used to define the attenuation as a function of time.

Reference

The reference for leveling a segment can be either the RMS signal level or the peak signal level. In general, modulated telecommunication signals are leveled using the RMS value whereas pulsed signals often use the peak value.

15.4.2 Frequency Settings

Static Offset

The frequency offset shifts the signal in frequency. You can add the same waveform at the same position to multiple tracks and then apply individual frequency offsets. The result is a multicarrier scenario.

It must be ensured that the target clock rate is large enough for the desired frequency shift and signal bandwidth. A minimum target clock rate of twice the signal bandwidth plus the frequency offset should be used.

Allow Deviation

The frequency offset entered by the user causes a constant phase shift between adjacent samples. The overall phase change between the first and the last sample depends on the target clock rate, frequency offset and the number of samples. If this total phase change is not a full multiple of $2\pi$, the beginning and end phase do not fit, and spectral regrowth can occur.
The figure below shows a CW signal that is frequency-shifted by 133 kHz. The phase at the waveform start does not match the phase at the waveform end. If this waveform were played continuously, spectral regrowth would occur due to this phase step.

This problem can be overcome by allowing the composer to adjust the frequency offset for phase matching between the waveform start and end.

The figure below shows the output signal when a 2.5 % deviation from the set frequency offset is allowed. The resulting frequency offset is 130 kHz.

**Expression**

Instead of a static frequency offset a mathematical expression may be used to define the frequency offset as a function of time.

Constants available in expressions:

- **PI**  The number pi
- **CLK**  The target clock rate in Hz
SOUT  The number of samples (output signal)
TOUT  The signal time (output signal)
ST    The sample time
C     The speed of light

Variables available in expression:
t    Current time
s    Sample index
dF   Frequency difference between last and current sample

15.4.3 Truncation

First Sample, Last Sample
By default, all samples from the waveform are used for a segment. Setting the first sample to a value greater than zero truncates the waveform at the beginning. The last sample may be changed to less than the maximum or remaining sample count for cutting away a signal portion from the waveform end.

15.4.4 Position in Output

Start Sample
The start sample sets the number of the first sample for the current segment in the output waveform. The start sample number is related to the target sample rate.

Start Time
The start time sets the point at which the current segment in the output waveform begins.

15.4.5 Flags

Truncate / Wrap Around
Usually, all segment content beyond the end of the waveform composition is truncated. Setting the segment mode to "Wrap Around" places the data that is beyond the end of the waveform composition at its beginning.

Use Markers
When this flag is enabled, the marker data from the segment waveform is added to the output waveform.

### 15.4.6 Fade-In and Fade-Out

Fading changes the signal amplitude at the beginning or end of the segment from zero to the full level. This setting is useful for reducing spectral regrowth at the joint between two segments.

![Diagram showing fade-in and fade-out](image)

Fading is indicated by a small arrow at the beginning or at the end of the segment. The arrow also symbolizes the direction of the level change.

**Time**

The period of time used for the level change between zero and full level. Leaving the time at zero disables fading.

**Shape**

The shape defines the profile that is used for changing the amplitude between zero and the full level.

![Diagram showing time and shape](image)
15.5 Target Waveform Settings

The target waveform settings specify all parameters related to the waveform that is generated by the composer engine. Besides the target file, the length and clock rate of the waveform can be specified.

**Target File**

The target file contains the absolute path and the file name of the output file. The path is internally saved relative to the composer settings file. This makes it possible to copy the settings file together with all waveform files to a different location. When this dialog is invoked, the original absolute path gets restored.

**Output Multi Segment Waveform**

The composer can create a multi-segment waveform file instead of a regular waveform if only one single track is used. Multi-segment waveform files contain individual
waveform segments that can be selected for single or repeated playback. A detailed description on multi-segment waveforms can be found in the instruments user manual.

**Length**

The length of the target waveform can be determined automatically or set by the user. All waveform data beyond the end of the waveform gets truncated or is wrapped around to the beginning.

**Longest Track Wins**

The length of the longest track determines the overall waveform length. This is the default setting, and it is useful in most applications. The length is updated with each editing operation.

**Longest Segment Wins**

The longest segment in any of the tracks defines the overall waveform length. This setting may be useful when multiple segments are added at the same point in time. The length is updated with each editing operation.

**User Defined**

In this mode, the length is fixed and set in samples or time. The length does not change with editing operations.

**Clock**

The target clock rate can be determined automatically or set to a fixed value. Automatic mode is the default setting here. This mode selects the highest of all segment clock rates. This, however, may not be sufficient when frequency offsets are used.

Segments that differ in clock rate require resampling during the building process. These segments are indicated with an "R" symbol in the track editor.

In automatic mode, the target clock rate is automatically adjusted during edit operations.

### 15.6 Building the Target Waveform

The target waveform is built from the entire scenario by pressing the "Run" button. The result is a single waveform file that contains the content specified in the composer window. Starting a waveform build is only possible if all waveform files are available and no segment is marked as offline. The building process consists mainly of the following steps:
► Read and analyze all source waveforms.
► Resample segments to the target clock rate where necessary.
► Frequency-shift segments where necessary.
► Assemble target waveform from all segments.
► Rescale and save target waveform.

At the beginning of the build process, the number of available CPU cores is detected. ARB Toolbox will spawn up to eight parallel processes for steps that can be carried out simultaneously. The build process will create several temporary files per CPU process in the system’s temporary directory. If the number of system resources is limited and errors occur during the build process, parallel processing may be disabled using the following command line option:

```
--no-multi-process
```

The build process can be started at any time and repeated multiple times. Existing target waveforms are replaced by newer ones.
16 Capturing with the Spectrum Analyzer

The spectrum analyzer capturing module records I/Q data using a spectrum analyzer and saves this data as a waveform file. The module can be invoked via the context menu for a folder entry in one of the local file-system browsers.

Before using the module, you must configure the spectrum analyzer for use with ARB Toolbox. This is done in the Instrument Configuration panel (Menu → Instrument → Configure). The spectrum analyzer is added in the same way as the signal generators are added.

Once a spectrum analyzer is added to the instrument list, it can be selected as a capturing source in the capturing module.

The first page of the capturing module provides all of the settings that define the capturing process. These settings are described below.
Input
The default signal input is the RF port. Alternatively, the analog or digital I/Q inputs can be selected. Depending on the spectrum analyzer, these options may not be available, and an error is generated during the capturing process.

Sample Rate
The sample rate sets the rate at which the spectrum analyzer samples the signal. Valid ranges must be looked up in the instrument manual, and they depend on the instrument, its options and the settings.

Samples / Time
The capturing process can be configured to either record a fixed number of samples or to record for a fixed period of time.

RBW
Sets the resolution bandwidth for the capturing process. Valid ranges must be looked up in the instrument manual. They depend on the instrument and its options.

Trigger Source
The default trigger source is immediate, which starts the capturing without waiting for a trigger event. Alternatively, the IF Power and External trigger modes are available if the instrument supports this setting.

Trigger Slope
This setting defines whether the trigger occurs at the rising or falling signal slope. It is valid for the External and IF Power trigger modes.

IF Power
This setting defines the trigger threshold in dBm when the trigger source is set to IF Power.

Pretrigger Samples
The number of pretrigger samples defines the sample count that is captured before the trigger event occurs.
The second page of the capturing module controls the capturing process itself. Text messages inform the user about the current capturing state.

Capture

The capture button starts a capturing process. This includes the following steps:

- Configure the instrument.
- Wait for the trigger and start the sweep.
- Wait for completion.
- Read the I/Q trace data to the PC.

Depending on the speed of the selected remote control interface, transferring a larger number of samples may take a significant amount of time.
Abort

Aborts the capturing process in the state where the analyzer waits for a trigger event.

The capturing process can be repeated multiple times. Previously recorded data is overwritten by new data. Once all data is captured, the Next ( >> ) button becomes available and leads to the page for rescaling the captured data. After the rescaling mode is selected, the captured data can be saved as a waveform file.
17 Remote Control

Some ARB Toolbox tasks can be executed via remote control command. The remote control is possible through the use of XML job descriptions which can be sent via TCP/IP connection. For this purpose ARB Toolbox can start a TCP/IP server and listen to an IP address. The server is started and configured with command line arguments.

--server
Starts the ARB Toolbox in server mode.

--ip=<IP address>
Sets the IP address of the server. If the IP address is not provided ARB Toolbox uses 127.0.0.1.

--port=<port>
Sets the port at which the sever listens for incoming connection. The default port is 5025.

17.1 Job Description

Ping
The PING Packet can be used to verify that the server is running. ARB Toolbox returns a status packet with the program version.

Job Description Packet:

<ATBJOB>
  <PING/>
</ATBJOB>

Response Packet:

<ATBSTATUS>
  <TYPE>PING</TYPE>
  <RESULT>OK</RESULT>
  <VERSION>3.7.6601.7261</VERSION>
</ATBSTATUS>
**Convert AIF to Waveform**

The comment and copyright tags are optional. The default comment contains the tuner frequency and bandwidth used for the AMMOS recording. ARB Toolbox accepts regular slashes and back slashes in the file name tag.

Job Description Packet:

```xml
<ATBJOB>
  <fromAIF>
    <infile>e:/temp/data.dat</infile>
    <outfile>e:/temp/out.wv</outfile>
    <comment>Imported from data.dat</comment>
    <copyright>My Company</copyright>
  </fromAIF>
</ATBJOB>
```

Response Packet:

```xml
<ATBSTATUS>
  <TYPE>JOBRESPONSE</TYPE>
  <JOB>fromAIF</JOB>
  <RESULT>1</RESULT>
</ATBSTATUS>
```

**Convert from .iq.tar**

The comment and copyright tags are optional. The fields rename empty if no information is provided in the job description packet. ARB Toolbox accepts regular slashes and back slashes in the file name tag.

Job Description Packet:

```xml
<ATBJOB>
  <fromIQTAR>
    <infile>e:/temp/data.iq.tar</infile>
    <outfile>e:/temp/out.wv</outfile>
    <comment>Imported from data.iq.tar</comment>
    <copyright>My Company</copyright>
  </fromIQTAR>
</ATBJOB>
```

Response Packet:

```xml
<ATBSTATUS>
  <TYPE>JOBRESPONSE</TYPE>
  <JOB>fromIQTAR</JOB>
</ATBSTATUS>
```
Convert from .wav

The comment and copyright tags are optional. The fields rename empty if no information is provided in the job description packet. ARB Toolbox accepts regular slashes and back slashes in the file name tag.

Job Description Packet:

```xml
<ATBJOB>
  <fromWAV>
    <infile>e:/temp/data.wav</infile>
    <outfile>e:/temp/out.wv</outfile>
    <comment>Imported from data.wav</comment>
    <copyright>My Company</copyright>
  </fromWAV>
</ATBJOB>
```

Response Packet:

```xml
<ATBSTATUS>
  <TYPE>JOBRESPONSE</TYPE>
  <JOB>fromWAV</JOB>
  <RESULT>1</RESULT>
</ATBSTATUS>
```
Contact information

Rohde & Schwarz GmbH & Co. KG
Mühlendorfstr. 15, 81671 München, Germany
Phone: +49 89 41 29 - 0
Fax: +49 89 41 29 12 164
Email: info@rohde-schwarz.com
Internet: www.rohde-schwarz.com

R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.

Trade names are trademarks of the owners.